s Office 2007

Benefits, Challenges and Compatibility

Microsoft Office 2007 is a big departure from previous versions. At
first glance it seems more alien than a meeting at Area 51. The good
news, however, is that after working with the software for about thirty
days, you will find it to be much more intuitive and productive than
earlier versions. In addition to the new interface, there are substantive
improvements important for legal, corporate and government entities.
For instance, there are new collaboration features in applications such
as Outlook and Word. The capabilities of Excel have been greatly
expanded, and PowerPoint is easier than ever to use. Of course, there
are some challenges in converting to 2007; the biggest ones are related
to compatibility. Fortunately, there are things that you can do to master
the sharing of documents, including planning for an upgrade.

This article provides compelling reasons for moving to Office 2007. At
the same time, we outline some areas that require caution during your
conversion process and provide recommendations for a painless
transition to the new version of software.

Microsoft Word

Make Keyboard Shortcuts Work for You

The first question that comes to mind when navigating in an Office
2007 application is, where’s the classic mode? Unfortunately, there is
no classic mode. Yes, there are third-party add-ins' out there that can
be used to reinstate a classic look-alike, but imagine having to train
and support the classic mode as well as the common features located
on the Ribbon (a graphical device that organizes commands into a set
of tabs). You would have to do double duty, and your users would
probably ask you why Microsoft made Office 2007 so complicated.

Instead, be reassured that many of the Word keyboard shortcuts still
exist in the 2007 version. While you learn to navigate the Ribbon, try
out a legacy keyboard shortcut, such as Alt+T, A (Tools, AutoCorrect
Options in Word 2003) to reach the AutoCorrect dialog box. It will feel
like a breeze compared to the laborious four clicks it takes to get there
manually: Office Button, Word Options, Proofing, AutoCorrect Options.
You can even press the Alt key to preview the KeyTips available in order
to access current Office Button and Ribbon commands.
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Building Blocks

The building blocks feature is the big sister to AutoText, offering
advanced selection, capture and reuse functionality, plus a whole lot
more. To create a simple building block, select existing text, press
Alt+F3, name the building block and click OK. To recall the building
block, type the name of the building block and press F3 to insert it into
the document. You'll find building blocks interspersed throughout
several Ribbons in 11 different galleries. The gallery name defines the
type of building block including Bibliographies, Quick Parts, Cover
Pages, Tables, Headers, Footers, Table of Contents and more. If you've
used AutoText in previous versions of Word, you'll enjoy the expanded
capabilities of this feature. When creating the building block, you can
also take advantage of another helpful option, which is the ability to
predefine where the building block is inserted in the document (footer,
header or cover page). Place your insertion point anywhere in the
document, and the building block is inserted at the cursor position.

Apply Styles Task Pane

Word 2007 now offers you more than a dozen different ways to apply
and modify styles. One of the most efficient is to use the Apply Styles
task pane. To open the task pane, press Ctrl+Shift+S, and the small,
unobtrusive task pane displays with the style name selected. Begin
typing the style name, and, if the AutoComplete Style Names option is
checked, as soon as the complete style name appears, press Enter or
click Apply. Alternatively, you can select the style from the drop-down
list. From this task pane, you can also quickly access the Modify Styles
dialog box or launch the Styles task pane for more options.

Applying Styles Without Inadvertently Creating New Character Styles
In previous versions of Word, if you selected text within a paragraph
and applied a paragraph style, this automatically created a character
style with the same name as the paragraph style. In Word 2007, the
same behavior holds true only when applying a linked style (a style
containing both paragraph and character formats). Fortunately, you
can now disable this action by opening the Styles task pane
(Alt+Ctrl+Shift+S) and selecting the Disable Linked Styles check box.
After enabling this option, you can select text, even across multiple
paragraphs, apply a linked style, and the style is applied to all
paragraphs selected. Character styles are no longer inadvertently
created when this option is enabled.



Outlook

Attachment Preview

Click on the file attachment in the Reading Pane to view a file without
opening it. This is a real timesaver when you think about how long it
would normally take to launch your document management system,
open Word and then display the document. The file previewers that
come with the 2007 Microsoft Office system allow you to preview
Outlook 2007 items, Word 2007 documents, PowerPoint 2007
presentations, Excel 2007 worksheets, Visio 2007 drawings, as well as
some images and text files.

Calendar Overlays

This feature will be a lifesaver for the busy legal secretary who
manages several attorneys’ calendars. Display the calendar and from
the View menu, select View in Overlay Mode. The end result is a single
calendar with color-coded appointments.

Share a Calendar at a Glance

Outlook 2007 lets you send someone with whom you are trying to
schedule an appointment a snapshot of your calendar for the next week
or two showing your free and busy time slots. In the Navigation Pane,
select Send a Calendar via E-mail, choose the span of time you wish to
send, and the selected dates appear in a new e-mail message. The
message and calendar are embedded in HTML format into the body of
the e-mail message. The calendar snapshot received is static and will
not update when new appointments are added; however, it's a very
useful feature.

To Do Bar

On the right-hand side of the Outlook window appears a To Do bar
containing an integrated calendar, task list and Outlook items for
follow-up. You can expand and even collapse the To Do bar so it
doesn’t encroach on the space available.

Electronic Business Cards

This feature makes it possible to design and send attractive business
cards with the information, look and layout you want to display. Create
a contact or open an existing contact, select Business Card in the
Options group on the Contact Ribbon and then change the layout, add a
picture, create a new label or choose from existing fields. As an added
benefit, secretaries supporting multiple attorneys can color code each
attorney contact for better organization.

RSS Manager

Outlook now allows you to subscribe to RSS feeds on the Internet and
have new content delivered to your Inbox. This eliminates the time and
energy it takes to surf and then sift through Web content. Subscribe to
sites related to your profession, network and cable news or even
technology sites.

Excel

Nearly Limitless Excel

While Excel has always been a superior product for number crunching,
data analysis and presentation, it has had its limitations with regard to
how much data could be placed in a single worksheet and how much
formatting could be applied. Excel 2007 shatters these limitations. For
instance, in Excel 2003, you could have a maximum of 65,536 rows and
256 columns. In Excel 2007, the maximum number of rows per worksheet
is 1,048,576 and 16,384 columns. Now that’s a lot of data. You also can

apply 4.3 billion colors (instead of 56), 10,000 AutoFilter items (previously
1,000), and 64 nested formulas (instead of just seven). These are just a
few of the increased capabilities of Excel 2007.

Resizable Formula Bar

In earlier versions of Excel, when a cell’s contents were longer than a
formula or sentence, the formula bar would expand and often cover up
much of the actual worksheet. Excel 2007 now includes a resizable
formula bar. Expand or collapse it with the simple click of a button.

Table Tools for Designated Tables

One of the biggest improvements in Excel is how tables are handled. Once
you define the worksheet as a table (Insert tab, Table), you have a host of
tools and functionality at your fingertips. AutoFilter is automatically
applied, and, if the list has a header row, it is automatically repeated
when you scroll down through your data. A Design Ribbon for Table Tools
is available for formatting and structure requirements.

Table Styles and Themes

Table styles and themes can be applied and even previewed with your
own data by hovering over the applicable Table Style group (Table Tools:
Design tab when a table is active). This makes formatting just as easy,
if not easier, to accomplish in Excel as it is in Word.

Redesigned Pivot Tables

Pivot Tables are powerful tools, and we're happy to report Excel 2007
still has this functionality, and it is improved over previous versions.
Instead of a Pivot Table and Pivot Chart toolbar, changes are made in a
task pane. Drag-and-drop fields into different pivot positions, or click
the corresponding check box.

PowerPoint

Reset Layout

Aside from adding bullet-point emphasis to your presentation,
PowerPoint is all about working with graphics and illustrations to paint
a picture for your audience. As you tweak and adjust the layout of your
slide content, you can click Reset in the Slides group on the Home tab
to bring the layout of the slide back to the original position.

Custom Slide Layout

If you find that you want to change a number of slides to a particular
similar layout, you no longer have to make those changes manually to
each slide. You can create custom slide masters that can be used
whenever needed. Click the View tab, select Slide Master from the
Presentation Views group. Select Insert Placeholder from the Master
Layout group and choose from Content, Text, Picture, Media and other
options. You can even rename the slide for easy insertion later. When
you create your presentation and want to insert a custom slide, click
Layout from the Slides group and select the layout you created.

Presenter View

If you have two monitors to use for your slide show presentation, you
can take advantage of the Presenter view option. One monitor displays
what the audience sees, and the Presenter view displays a separate
window for the presentation, notes and narrator tools. This simplifies
the process for the presenter and ultimately makes it a pleasant and
seamless experience for the audience. To take a look at this exciting
and easy-to-use tool, click the Slide Show tab, and, in the Monitors
group, select Use Presenter View.

Microsoft :: 5



Tips for a Better Migration

The more pre-rollout planning an IT department does, the easier time
users will have adjusting to the new workstation environment. For
example, before the rollout, you can turn off the features that are not
applicable to your organization, and you can customize things like
building blocks, heading styles and margins. You can also set up
templates to aid the users.

Make Tools Available

If you know where a command is in 2003 and are not yet familiar with
where it is located in 2007, you can download interactive guides (7he
Interactive Word, Excel and PowerPoint 2007 Command Reference
Guides) for Word, Excel, and PowerPoint that cover the most popular
commands used in the 2003 versions. After downloading the guides
from the Microsoft website, launch the executable for the desired
application. Click the menu or toolbar command on the 2003 interface,
and a window containing the 2007 interface displays graphically the
2007 equivalent commands in corresponding order. This is a handy tool
for getting started when navigating the new 2007 user interface.

Using the Viewers

You can read, copy, and print Word 2007, PowerPoint 2007 and Visio
2007 files without installing the individual application by downloading
the viewers from the Microsoft website. Unfortunately, for Excel 2007
files, you would first need to install the Compatibility Pack and then
download the Excel Viewer 2003. See the compatibility section of this
article for more information on the Compatibility Pack.

Customize the Quick Access Toolbar

There are only two toolbars in Word: the mini toolbar, which appears
when text is selected in a document, and the Quick Access toolbar,
which appears by default at the top of the window. This toolbar can be
moved below the Ribbon for convenience. To help your users work more
productively, the toolbar can also be customized to include the buttons
and commands they use most frequently.

Compatibility

At the top of the list of challenges in working with Office 2007 is
compatibility. Because you are probably already receiving Office 2007
files, you may already be aware of the compatibility issues when
working in earlier versions of Office. And, of course, the Compatibility
Pack is only available for Office 2000-2003, so there is no solution
currently available if you are running Office 97.

Compatibility is a big challenge because it has essentially turned out to
be a trial-and-error process. For example, even though you may be able
to open and edit a Word 2007 file in Word 2003, you may easily run into
something you cannot edit. Even worse, you may be able to edit a file,
but when you send it back to the recipient with whom you are
collaborating, it doesn't display as expected. What is happening here is
the Compatibility Pack is trying to convert the file as best it can;
however, the results are not predictable or consistent, and it's not
always 100 percent seamless.

Needless to say, the collaboration efforts between firm and client
require even more file exchanges, and the unintended changes made to
these files during the conversion process can cause a lot of frustration.
This is a concern especially for the late-night lawyer who doesn’t want
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to be bothered with the reasons the file doesn’t exchange well, but just
wants uninterrupted, seamless file exchange.

Your best solution would be to provide several workstations with Office
2007 installed throughout the office, and use these workstations (or
Citrix) to edit a 2007 file in order to maintain the native file format
without conversion. And as a stop-gap measure, add the Compatibility
Checker to the Quick Access toolbar to see what will be affected when
working in Compatibility mode.

More Challenges

We could write another complete article describing how to replicate
known problems and reported bugs (several found in Microsoft's
knowledge base articles and others found in the various Office 2007
newsgroups in addition to what we’ve found when teaching our Master
Series course). However, we believe that most of these issues will be
resolved with subsequent service pack releases of Office 2007. Any firm
rolling out Office 2007 will need to study the known problems and bugs
and then integrate solutions and possible workarounds into their
training and support plan. Those who are waiting for the service pack
releases before rollout may be able to focus attention on all of the great
new and improved features in Office 2007.

Recommended Strategies for Deployment and Challenges
The greatest challenge in planning an Office 2007 rollout is to
remember that this migration is not just a simple upgrade. There are
many items associated with the planning process that must be taken
into consideration. The following checklist will help get you started:

Consider rolling out the Compatibility Pack right away. The
Compatibility Pack is a Microsoft download that allows the Office
2000-2003 user to open, edit and save Office 2007 files.

Study the Office 2007 features that are not compatible with your
present version of Office. Plan how to handle collaboration with
clients and other external sources before sharing files with an
Office 2007 user.

Create a Design Flowchart for how to treat incoming and outgoing
documents in Office 2007 format. If applicable, set up
workstations dedicated to working on files in this format.

Allow ample time in order to plan for the rollout. Firms with
multiple offices and languages should consider a nine-month to
one-year plan for their efforts.

Study the minimum hardware and software requirements, and plan
on raising the requirements higher for best results.

Work with third-party vendors to create a timeline of integration
with Office 2007.

Test new releases of vendor add-ins with Office 2007.

Purchase or create templates that take advantage of the new
functionality offered with Office 2007. This may require training to get
up-to-speed with the new content controls available in Office 2007.

Get high-level training for in-house trainers and user support
personnel.

Plan for instructor-led, end-user training.

Plan for floor support resources for three to five days post-rollout.



Office 2007 offers many benefits over previous versions, and some of
the highlights are noted herein. There are issues to consider, however,
when moving to the new software. It's fair to say that this version is
very different from its predecessors, and as such, the conversion will be
more complex. At the top of the list of complexities to address is
compatibility. Just because this is a Word-to-Word or Office-to-Office
conversion doesn’t mean that it should be taken lightly. There are new
file formats, new functionality and new features that are not backward-
compatible. This upgrade takes planning, preparation and some good

old-fashioned sweat to pull off. However, with the proper planning, a
solid conversion plan and a team effort between firms and their trusted
vendors, the result is definitely worthwhile.

! Classic Menu for Office 2007 v3.5 is one of the add-ins you can
purchase to bring back menus in Office 2007; however, there are
imitations to what you can do with this tool.
(www.addintools.com/english/menuoffice/default.htm)

This article was first published in ILTA's January, 2008 white paper titled “Microsoft — Beyond 2007" and is reprinted here with permission. For more information about ILTA, visit their website

at www.iltanet.org.
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